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1 Introduction 

Thank you for choosing the Daintree Networks’ Sensor Network Analyzer Basic Edition. The Sensor 
Network Analyzer (SNA) Basic Edition consists of a powerful protocol analyzer for 802.15.4™ 
networks and ZigBee™ applications.  

This software is compatible with the Atmel STK541 USB Adapter Board included with your Atmel 

AVR Z-Link® RZ541 Packet Sniffer Kit, as shown below. No additional hardware is required. 
 

USB

Atmel STK541

USB Adapter Board

USB

Atmel STK541

USB Adapter Board

Atmel STK541

USB Adapter Board

 

 

To use the SNA application software in conjunction with the Atmel Adapter Board: 

1. Install the Sensor Network Analyzer software 
2. Install sniffer firmware on the USB Adapter Board (ref chapter 3.1) 
3. Connect USB Adapter board to a USB port on the PC and install the USB drivers 
4. Start the SNA Application and Select the Atmel USB Adapter Board as the capture device 

Each of these steps is described in a subsequent section of this document. For more information on the 
use of the Sensor Network Analyzer software, consult the Sensor Network Analyzer User Guide, which 
is included as part of the SNA software installation, and available from the SNA Help Menu and 
Windows Start Menu. 
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2 Installing the Sensor Network Analyzer Software 

This section describes how to register, install, and activate the Sensor Network Analyzer software. 

2.1 Registering the SNA Software 

The Sensor Network Analyzer software distribution includes a unique registration code printed on the 
back of the CD case (15 digit alphanumeric code, AAA-AAA-AAA-AAA-AAA). This registration 
code is required to register your copy of the software with Daintree Networks.  

1. Go to the Daintree Networks web site address: http://www.daintree.net/register 
2. Follow instructions on that page to proceed to the registration page. 

 

3. Enter the registration code printed on the back of your CD case, along with your email address, 
and click Next.  

4. Upon verification of the registration code, you will be directed to a subsequent registration page 
similar to the following: 

http://www.daintree.net/register
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5. Complete the remainder of the registration process and click Submit. 
6. You will be redirected to a download page for the SNA installation package. You can check for 

the availability of a more recent software release than the version provided on your CD and 
download it if necessary. 
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2.2 Installing the Sensor Network Analyzer 

To install the SNA software, follow these steps: 

1. Make sure you have at least 100 MB of available disk space, 
2. Run the SNA install executable 

o CD Version: Insert the Sensor Network Analyzer CD; the installation starts 
automatically. If the installation does not start automatically, browse to the CD and 
manually run Setup.exe, 

o Downloaded Version: unpack the zip file SNA_Setup_v#.zip, and run the resulting 
executable SNA_Setup_v#.exe (where the # is replaced with a version number), 

3. Follow the installation instructions: 

o Read and accept (or decline) the License Agreement (as shown below), 
o If you accept the License Agreement: 

� Enter User Information, 
� Accept the default installation location, or choose an alternative location, then 

proceed through confirmation to begin the install process, 
o If you have a previous version of the SNA it will be automatically uninstalled at this 

time, 
o The Installation will proceed to completion. 

As described above, the End User License Agreement is presented at installation time and outlines the 
full terms and conditions of use. Subsequent to installation, this file can also be viewed in the Daintree 
Networks\Sensor Network Analyzer installation directory or from the Start menu.  
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Once the installation is complete you will be presented with the following screen. It is suggested that 
you view the readme file at this time, which contains notes specific to this release. Select ‘Launch the 
Program’ to continue with the activation process. Otherwise run the application at a later time when 
you are ready to activate. 
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3 Setup the Atmel USB Adapter Board 

This section describes the detailed steps required to setup the SNA application for use with the Atmel 
STK541 USB Adapter Board. The USB Adapter Board is included as part of the Atmel Development 
Kit.  

3.1 Install Sniffer Firmware 

To use the USB Adapter Board as a sniffer device it must include the Radio Controller Board as an 
attachment. Furthermore, special sniffer firmware must be downloaded to the board.  

The firmware used with a given version of the Daintree Networks’ Sensor Network Analyzer is 
installed in the “Daintree Networks\Firmware\Atmel” directory. 

The following subparagraphs provide instructions to program (reflash) the RCB. 

3.1.1 Programming the RCB 

The following steps show how to reflash the Atmega1281 microcontroller located on the RCBs. 

1. Connect the 6-pin cable from the AVRISP MKII to the RCB ISP connector (upper left) on the STK541 
Board, ref the picture below. 

 

 

2. Refer to the user's guide for the appropriate programmer. 

3. Select the target device as the Atmega1281. 

4. Ensure that the following fuse settings are selected using AVR Studio: 

a. Brown-out detection disabled; [BODLEVEL=111] 

b. JTAG Interface Enabled; [JTAGEN=0] 
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c. Serial program downloading (SPI) enabled; [SPIEN=0] 

d. Preserve EPROM memory through chip erase cycle. [EESAVE=0] 

e. Boot flash section size=4096 words Boot start address=$F000; [BOOTSZ=00]; default value 

f. INT RC OSC.: Start-up time:6 CK+65mS; [CKCEL=0010 SUT=10] 

g. Program the fuses; the final fuse value written shall be 0xFF, 0x91, 0xE2. 

5. Program the flash with the application 

 

 

3.2 Install USB Driver 

Connect the USB Adapter Board to the PC’s USB port. The first time you connect the USB Adapter 
Board to your PC’s USB port, the Found New Hardware wizard will prompt you to install drivers for 
the new hardware. 

1. Select “Install from a list or specific location” and click Next.  
2. Select “Search for the best driver in these locations”, and “Include this location in the search” 

and Browse for the “Daintree Networks\Drivers\Atmel” directory.  
3. Select Next and the wizard will automatically find and install the required drivers.   Note that 

during installation you will see a Windows warning message “The software you are installing 
for this hardware: Atmel USB Adapter Board has not passed Windows Logo testing to verify its 
compatibility with Windows XP.”  Click Continue Anyway. 

The Atmel USB Adapter Board is now ready for use. 

3.3 Select Atmel USB Adapter Board as Capture Device 

You are now ready to startup the Sensor Network Application and to select the Atmel USB Adapter 
board as the active capture device. 

1. Start the Sensor Network Analyzer application (Start->All Programs->Daintree Networks-
>Sensor Network Analyzer) 

2. Select Capture Source directly from the app toolbar or using the Capture->Select Source… 
menu item.  

3. From the list of available capture devices, select the Atmel USB Adapter Board 

If the Atmel USB Adapter Board is not in the list of available capture devices, ensure the board is 
connected to the PC’s USB port and not being used by another software application. Then, click the 
magnifying glass icon to search for capture devices. If the USB Adpater Board is correctly connected it 
will be shown in the list of available devices. 
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1. Select Capture Device 3. Start Capture2. Select channel1. Select Capture Device 3. Start Capture2. Select channel

 

Select a channel, start capture and if packets are detected on the selected channel you will see a 
scrolling list of capture packets in the Packet List window. 

Consult the Daintree Networks Sensor Network Analyzer User’s Guide for more detailed information 
on how to use the application. 

Known Limitations 

Multiple USB Adapter Boards cannot be used with the SNA simultaneously. If multi-point capture is 
required you should use multiple Daintree Networks Sensor Network Adapters. 

If the USB Adapter Board is in use by the SNA application it may not be used concurrently by any 
other application. 

If the USB Adapter Board is not detected by the SNA application the first time it is connected to the 
PC’s USB port, try disconnecting and reconnecting again, and then select the magnifying glass icon to 
refresh the list of available capture devices. 
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4 Getting Started With the SNA 

To get started with the SNA application, launch the application. From the Start menu, choose All 
Programs, Daintree Networks, Sensor Network Analyzer – Atmel OEM Edition. 

Packet ListToolbars Packet Decode

Packet Timeline Packet Data

Packet ListToolbars Packet Decode

Packet Timeline Packet Data
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You will see each of the major components of the SNA application: 

• Packet List window, used to display a scrolling list of packets, 

• Packet Decode window, which provides the detailed decode of the selected packet in the 
Packet List, 

• Packet Data window, providing a hex decode of the selected packet, 

• Packet Timeline window, providing a graphical view of the packet list by device. 

Each window can be maximized, minimized, hidden, or resized. 

All application windows can be reached from the menu items listed in the menu bar along the top of the 
main application window. The View menu can be used to toggle the display of each window (and 
toolbar). The Window menu can be used to bring a given window to the front and to control the display 
of the currently enabled windows. Toolbars are available for the most commonly used features. 

Opening an Example Capture File 

The best way to learn the key features of the application is to open files previously captured from live 
networks. This can be done prior to installing capture hardware.  Sample capture files are provided with 
the standard installation and can be found in the Daintree Networks/Sensor Network/Analyzer/Capture 
Files directory. 

Use the File -> Open menu item or corresponding toolbar item to open the example “HCL_Demo.dcf” 
file. This can be found in the “Capture Files” directory. Select packets using the Packet List or 
Timeline window. The selected packet is shown in The Packet Decode and Packet Data window. 

SNA Operating Model 

The SNA is able to operate in two modes: 

• Live network analysis; 

• Post-analysis of capture files previously captured from a live networks. 

The following diagram highlights the major components of the SNA and how data from live networks 
or previously captured files are processed by these different components. 
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Figure 1 SNA Operating Model 

The available controls include: 

• Start/Pause/Stop Capture: these are the master controls when the analyzer is capturing from a 
live network. When capture is started, ALL data from a previous capture is cleared including 
the Packet List, the Device Tree and any measurements, 

• Play/Pause/Step/Fast Forward Playback: this is the master control when playing back a 
previously captured file. Playback is started by opening a file and is stopped after the last 
capture record in the file. 
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5 Capture and Playback 

This section describes the features used to capture live traffic, to save/log capture files, and to playback 
capture files.  

5.1 Live Capture 

Prior to initiating live capture, it is necessary to: 

1. Select a Capture Device (Source) from the list of available capture devices, 

2. Select a Channel. 

These controls are available from the Capture Source Toolbar and the Capture Menu. The Capture 
Source Toolbar is shown below. 

  

Figure 2 Source Toolbar 

Each of the Source toolbar items is described below. 

Select Source Select Source enables selection of the active capture device for the capture 
session. If there is a capture operation in progress, or an open capture file, this 
toolbar item is disabled.  

The Source drop down list will list all available capture devices.   

 

(Search for Capture Devices)  This operation will search for new capture 
devices and update the list of available devices.  Refer to the sections of this 
manual detailing hardware configuration for more information. 

Channel Select from the list of available channels using the drop down list. The channel 
number is shown in both decimal and hexadecimal. Note that only valid 
channels for the specific source device are listed. The frequency of the selected 
channel is displayed next to the selected channel.   

 

Channel Scan. Scan for network activity on a selected set of channels. 

Starting a Live Capture Session 

A capture session represents a continuous period of time during which all air interface activity detected 
by each active capture device is captured to memory. All incoming data during a capture session can be 
logged to disc as it arrives. Alternatively, the capture data can be saved to a log file post-capture.  In 
this way it can be retrieved and analyzed at a later time. A capture session can be initiated and 
controlled using the Capture Menu or the Capture Toolbar.   
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Figure 3 Capture Menu 

Each of the Capture Menu items is described below: 

Select Source… Allows selection of a capture source through a dialog box.   

 

The dialog box includes the search button, drop down list of 
sources and channel selection.  

Start Capture Starts capture on the selected device.   

Pause Display Pause/Resume display of captured data, allowing you to check through the 
data while capturing continues.  

Stop Capture Stops capture operation. 

Breakpoint Menu Provides access to the Breakpoint menu as described in Section 5.4 below. 

Capture controls are also available from the Capture Toolbar. 

 

Figure 4 Capture Toolbar 

Each of the Source toolbar items is described below. 

Start Capture 

 

Begins a new capture session.  If there is no capture source selected or if a 
capture operation is already in progress this menu item is disabled.  

Pause Display This will not pause the capture session itself, but will pause the display such 
that new incoming packets are not presented in the Packet List until the pause 
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state is released.  This can be useful for studying existing display contents 
without the distraction of updates being presented. If there is no capture 
operation in progress, this menu item is disabled. Clicking the ‘Pause 
Display’ toolbar button again will release the pause state and all pending 
packets will be displayed. 

Stop Capture 

 

Clicking on this toolbar button (or selecting the action from the Capture 
Menu) terminates the capture session.  If there is no capture operation in 
progress this menu item is disabled. 

Replay Factor: Not applicable, and is disabled, for live capture. This option affects capture 
playback and is described below in the Capture Options section. 

 

Insert 

Breakpoint: 

 

Allows breakpoints to be inserted into the capture file. Breakpoints are 
inserted before or after the selected packet in the packet list. This button is 
disabled unless there is a currently selected packet. See Section 5.4 below for 
more details. 

Remove 

Breakpoint: 

 

Allows the selected breakpoint to be removed from the capture file. This 
button is disabled unless a breakpoint is selected in the packet list. See 
Section 5.4 below for more details. 

After capture is stopped, you have the option to save the current capture session to file using the Save 
option available from the File menu or the File Save icon from the File toolbar. If breakpoints have 
been added, the File must be saved. Otherwise the breakpoints will be discarded. 

5.2 Playback of Capture Files 

The Sensor Network Analyzer (SNA) allows the playback of capture files previously captured from 
live networks. This section describes the different options available when playing back capture files. 

Playback is initiated by using the File Open operation available from the File menu or File toolbar. This 
option presents a standard file selection dialog. Browse to the required directory, choose the file to 
open and press the Open button. The file is shown in the Capture Source toolbar.  

Once a file is open, a number of playback controls are available to control the playback of the capture 
file. These playback controls are available from the Capture menu and Capture toolbar. 

 

Figure 5 Playback Controls (during Pause and Play respectively) 
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Play 

 

Play will load packets from the currently open capture file based 
on the timestamps stored in the file. This will play back packets 
with the same timing from when the packets were captured. The 
playback speed can be increased by an integer multiplier using 
the Replay Factor setting which can be modified from the 
Capture menu or from the Capture options. 

Play is available from the Pause or Fast Forward state. In the 
Play state the Play button is disabled. 

Step 

 

Play a single packet and return to the Pause state. Step is available only when 
paused. In the Play or Fast Forward State the Step button changes to a Pause 
button. 

Pause 

 

Pause playback. The Pause button is available in the Play or Fast Forward 
state. In the Pause state the Pause button changes to a Step button. 

Fast Forward 

 

Load packets from the capture file at the maximum possible rate. Fast 
Forward is available from the Pause or Play state. 

Replay Factor: This option affects capture playback and is described below in the Capture 
Options section. 

 

Insert 

Breakpoint: 

 

Allows breakpoints to be inserted into the capture file. Breakpoints are 
inserted before or after the selected packet in the packet list. This button is 
disabled unless there is a currently selected packet. See Section 5.4 below for 
more details. 

Remove 

Breakpoint: 

 

Allows the selected breakpoint to be removed from the capture file. This 
button is disabled unless a breakpoint is selected in the packet list. See 
Section 5.4 below for more details. 

Each of these playback controls is also available from the Capture Menu. 

5.3 Capture Options 

There is a Capture Options tab available from the Options dialog, accessible from the Settings menu. 
The Capture Options tab is as shown below. 
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Figure 6 Capture Options 

The following options are available: 

Clear Display on Capture 

Start 

To erase the existing packet list display contents 
at the start of a new capture session. If this option 
is not selected, the packets from the next capture 
session will be appended to those from the 
current session. 

Include FCS Errors If enabled, packets with FCS errors are forwarded 
to the Packet List, otherwise they are discarded. 

Auto Scroll If enabled, the Packet List will automatically 
scroll to show the latest packets as they arrive. 
This option is also available on the Capture 
Toolbar. 

Startup State 

 

This option determines the initial state when a 
capture file is opened for playback. Based on this 
selection, the capture file will be opened in the 
Pause, Play or Fast Forward state. 

Replay Factor When playing back capture files in the Play state 
the file is played back according to the 
timestamps in the capture file. The replay factor 
allows play back to be sped up by an integer 
multiple of the timing based on the actual
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timestamps. 

Show Breakpoint detected 

dialog 

Breakpoints are described in the next section. 

When a breakpoint is detected during playback, 
playback is paused at the breakpoint. This option 
determines if the ‘Breakpoint Detected; dialog is 
displayed or not.  

5.4 Breakpoints 

Breakpoints can be used to mark interesting events in a capture file. During playback of a capture file, 
the playback will pause whenever it reaches a breakpoint. 

 

Figure 7 Breakpoint Detected Dialog 

Breakpoints are described using a user defined textual label. 

Inserting a breakpoint 

Breakpoints can be inserted during live capture or during playback. Breakpoints are inserted before or 
after the currently selected packet in the Packet List (the Packet List is described below). The Add 
Breakpoint command is available from the Capture menu, from the Capture toolbar, or from the 
context menu displayed when right-clicking on a packet in the packet list. 

  

Figure 8 Add Breakpoint (from Capture Menu) 
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Add 

Breakpoint

Add 

Breakpoint

 

Figure 9 Add Breakpoint (from Capture Toolbar) 

 

Figure 10 Add Breakpoint (from Packet List, Context Menu) 

When adding a breakpoint you will be presented with the Add Breakpoint dialog. 

 

Figure 11 Add Breakpoint Dialog 

A breakpoint can be added before or after the currently selected packet, depending if the packet marks 
the end of an interesting event or the beginning of an interesting sequence of packets. You may enter a 
text string into Information Text field to describe the breakpoint. A breakpoint is identified by its 
position in the capture file and by the identifying information text label. This label is then displayed 
when the breakpoint is encountered the next time the given file is played. 

Removing a breakpoint 

Once added, a breakpoint appears as a separate line in the Packet List. The breakpoint is shown using a 
red circle on the left hand side together with the user defined information text associated with the 
breakpoint. 
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A breakpoint can be removed by selecting the breakpoint in the Packet List and by choosing the 
Remove Breakpoint action available from the Capture menu, from the Capture toolbar, or from the 
Packet List, right-click Context menu. 

  

Figure 12 Removing a breakpoint 

Once a breakpoint is selected, the following other operations are also available: 

• Edit…, to change the information text associated with the selected breakpoint, 

• Enable/Disable, to turn the breakpoint on or off, 

• Remove All, to allow all breakpoints to be removed in a single operation, 

• Enable/Disable All, to turn all breakpoints on or off in a single operation. 

NOTE: After adding and removing breakpoints, the capture file must be saved to preserve the changes. 
Failure to save the file will result in any changes being discarded. 

Master Disable 

The Capture Breakpoint menu provides a “Master Disable” function that will ignore all breakpoints in 
the capture file during playback. This will not change the state of the individual breakpoints in terms of 
whether they are enabled or not. The “Master Disable” function can be toggled to turn it on and off and 
a checkbox is shown next to the menu item when it is on. 
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Figure 13 Breakpoint Master Disable  

5.5 Logging 

When enabled, logging automatically saves incoming packets to file as they are received. This is a 
background activity, transparent to the user.  An alternative to logging is to save a capture session to a 
log file at the end of that session. Logging options are available from the Options dialog which can be 
accessed from the Settings Menu. 
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Figure 14 Logging Options 

Each of the available options is described below: 

Enable Logging Background logging will not occur unless this box is checked.  
If logging is disabled, all remaining fields in this tab will be 
inactive.  The application will initially default to logging 
disabled. 

Open log file for each This radio button selection allows you to determine whether 
the log file logic is executed once only at application start up 
time or each time a capture session is started.  If ‘Application 
session’ is selected, one log file will be created, consisting of 
all data including that from multiple capture sessions.  If 
‘Capture session’ is selected, a new log file will be created at 
the start of each capture session. That is, the log file is opened 
concurrent with a Start Capture operation, and closed when a 
Stop Capture operation occurs. 

Prompt for filename If checked, each time the application launches or a capture 
session is initiated (depending upon the ‘Open log file for 
each’ preference) you will be prompted to manually enter a 
log file name. 

Filename Specifies the log file name. If ‘Prompt for file name’ is 
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selected this field will be disabled and its contents ignored.   

The file extension defaults to .dcf unless otherwise specified, 
and data will be logged using the default format. Refer to the 
description of capture file formats later in this document for 
more information.  The contents of this field will default to the 
last filename specified even if it is from a previous 
application session. 

To enable automatic unique file name creation, the file name 
may be constructed from or appended with date and time 
descriptors.  For example, specifying 
c: \ t emp\ mycapt ur ef i l e_%M%D%Y_%h%m%s. dcf  would result 
in a log file name of the format  
c: \ t emp\ mycapt ur ef i l e_08272004_140312. dcf . This can 
be used to automatically create unique filenames for each 
capture session. 

When an existing log 

file is opened 
This radio selection will allow you to specify what happens to 
an existing log file of the same name when the log file logic is 
executed. If ‘Overwrite’ is selected the log file will be 
overwritten without warning. If ‘Append’ is selected the log 
file is appended with new data. 

Enable Multi-node 

logging 
When selected, additional multi-node debug information is 
written to a companion log file which uses the same filename 
as the log file but appends an additional “.dbg” suffix. 

Typically this option should only be enabled when instructed 
by a Daintree Networks’ Support Representative. This file 
will then typically be sent back to Daintree for analysis. 
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5.6 Status Bar 

There is a status bar along the bottom of the Main Window that looks like the following: 

Frame 

Counter

Log FileContext Sensitive 

Help
Frame 

Counter

Log FileContext Sensitive 

Help
 

Figure 15 Status Bar 

The Status Bar consists of the following items: 

Context Sensitive 

Help 
Updates as cursor moves over items in the application. 

Log File Displays the current log file as selected in the Logging Options.   

Frame Counter Shows the total number of frames in the current capture or playback session. If 
a Filter is applied the counter will update to say “Frame M of N” where M is 
the number of frames displayed in the Packet List (those matching the filter) 
and N is the total number of frames in the current capture or playback session. 
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6 The Protocol Decoder 

Together the Packet List, Packet Decode and Packet Data, and Packet Timeline windows provide a 
comprehensive protocol decoder for 802.15.4 and ZigBee networks.  

Packet ListToolbars Packet Decode

Packet Timeline Packet Data

Packet ListToolbars Packet Decode

Packet Timeline Packet Data
 

Figure 16 Protocol Decoder 

Packet List Window Lists received packets sequentially with summary information. 

Packet Decode Window Displays the decoded structure of an individual packet. 

Packet Data Window Displays the packet data itself in hexadecimal and ASCII. 

Packet Timeline Display packet events for each device in the network 
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6.1 Packet List Window 

 

Figure 17 Packet List Window 

The Packet List shows a summary of each packet in the current capture session. Display filters can be 
used to define a subset of packets for display. For example, MAC command frames may be filtered for 
display.  Each individual packet is listed on a separate line, and includes summary information for that 
packet.   

The packet list can be sorted according to the value of any of the available summary fields by clicking 
on the column header for that field. Each subsequent click on the column header will toggle between 
sorting the list in ascending or descending order. By default the packet list is ordered based on the 
Sequence Number which results in the packets being listed sequentially in the order they were received.  

Selecting a packet in the list (by clicking on it) will result in a decode of that packet appearing in the 
Packet Decode window (if open).  The packet list can be scrolled through using the up and down arrow 
keys.   

Packets in the packet list are colored based the protocol contained in the packet. 

The available summary fields are as follows. You can control which fields are shown (fields that are 
disabled by default are highlighted as such in the table below). 

Index Index (sequence) number of the packet.  The index is initialized to 1 at the 
beginning of a capture session.  Note that indices are assigned sequentially to 
all packets received, so an index missing in the Packet List is indicative of a 
filter being applied. 

Time  Time at which the packet was received, as provided by the capture device. The 
format is ‘seconds.microseconds’ where ‘seconds’ is the time in seconds since 
midnight, January 1, 1970, and ‘microseconds’ is an offset in microseconds 
from this time.  

Src PAN The MAC Source PAN field (disabled by default) 
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Src The MAC source address field. 

Dest PAN The MAC Destination PAN field (disabled by default) 

Dest The MAC destination address field. 

MAC Seq No The MAC Sequence Number (disabled by default) 

NWK Src The NWK source address field. 

NWK Dest The NWK destination address field. 

NWK Seq No The NWK Sequence Number (disabled by default 

APS Src EP The APS Source Endpoint (disabled by default) 

APS Dest EP The APS Destination Endpoint (disabled by default) 

APS Profile The APS Profile ID (disabled by default) 

APS Cluster The APS Cluster ID (disabled by default) 

AF Seq No Application Frame Sequence number (disabled by default) 

Protocol The appropriate protocol layer corresponding to the packet.  All packets will 
be decoded to the maximum extent possible, unless protocol layer decoding is 
disabled through the Protocols Menu. 

Packet Type The actual packet type.  For example, ZigBee NWK layer packet types may be 
‘Command’ or ‘Data’. 

The list of summary fields can be manipulated using the Packet List Options dialog available from the 
Settings -> Options menu item. 
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Figure 18 Packet List Options 

Packet List Options are available to: 

• Select which fields to use as columns in the Packet List, 

• Choose colors used for the Packet List, 

• Choose the Timestamp resolution used in the Time and Time Delta columns. 

6.2 The Packet Decode Window 

The Packet Decode window shows the decoded structure of the packet currently selected in the Packet 
List window.   

The packet decode appears as an expandable tree.  The state of each node defaults to ‘collapsed’ when 
the application starts.  Clicking on a node (the [+] or [-] symbols) will expand or collapse that branch of 
the tree accordingly.  The application will remember which nodes in the decode tree have been 
expanded. As subsequent packets are selected, the same expanded or contracted state of equivalent 
nodes will be carried over, provided they are contained within the packet. 
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Figure 19 Packet Decode Window 

Right-clicking on a node inside the Packet Decode tree brings up the context sensitive menu.   

 

Figure 20 Packet Decode Context Sensitive Menu 

Expand/Collapse Expands or Collapses the current level of the tree 

Add to Filter… Opens the Define Filter… dialog with a pre-defined filter 
based on the highlighted field and its current value. 

Copy As Text Copy the requested text to the Clipboard for pasting into 
another application (e.g. text editor) 

Expand/Collapse All Expands of Collapses the entire decode 
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Selecting particular fields within the Packet Decode window will cause the packet data corresponding 
to that field to be highlighted in the Packet Data window when that window is displayed.   

6.3 The Packet Data Window 

The Packet Data window displays all data contained within the packet in raw hexadecimal and ASCII 
form.  The first column is an octet index. Packet data corresponding to a field which has been selected 
within the Packet Decode window will be highlighted.   

 

Figure 21 Packet Data 

Selecting particular bytes in the Packet Data window will automatically highlight the corresponding 
fields in the Packet Decode window. 

6.4 Packet Timeline 

The packet timeline window displays observed packet events on a per-device basis. This gives a quick 
summary of which devices are active in the capture session. 

 

The user can select a packet event in the timeline. This will select the corresponding packet in the 
packet list and the selected packet will then be shown in the Packet Decode and Packet Data window. 

Similarly, selecting a packet in the Packet list will select the corresponding packet in the Packet 
Timeline window. 

6.5 Protocol Decoder Display Filters 

Display filters provide a means of pre-selecting the types of packets displayed within the Packet List 
(and hence Packet Decode and Packet Data) windows.  This can be useful when wishing to observe 
particular device or network activity, for example, only NWK layer commands initiated by a particular 
device.  
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Display filters invoke filtering for display purposes only.  In other words they limit what is displayed 
according to the conditions specified by the filter.  Defining and applying a filter will not result in data 
accumulated within a capture session to be discarded.  When a display filter is removed, the Packet List 
window will revert to containing all received packets during that particular capture session. 

Display filters are applied to the protocol decoder windows only.  They do not provide filtering for 
measurements or visualization. 

Defining Filters 

Several methods are available to define a filter. 

• Using the Filter Menu or the Filter Toolbar (if displayed).  See below. 

• By right clicking on a field within the Packet Decode window.  Right clicking on a field within 
the Packet Decode window will provide an option to define a new filter using that field by 
means of the ‘Define Filter’ menu item.  Selecting this will launch the Define Filter dialog box 
with the field in question pre-selected. 

Filter Menu and Filter Toolbar 

The Filters Menu may be used to define the filter conditions. 

 

Figure 22 Filters Menu 

Define… This menu item brings up the ‘Filters’ dialog box. If a capture 
operation is in progress, this menu item will be disabled. 

Filters may also be defined using the Filters Toolbar.  In addition, the Filters Toolbar allows Filters to 
be applied or reset.   

 

Figure 23 Filters Toolbar 
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Filter: Indicates any display filter currently applied.  If no filter is 
active then the field will be blank.  A drop down list can be used 
to retrieve recently defined filters.  An existing filter may be 
edited or a new filter typed or pasted into this toolbar field.  

This drop down list will display the filter as it is being created 
and will also allow you to manually update the filter string. You 
will also be able to choose from the drop down list any of the 
last 10 defined filters. 

Reset Filter 

 

Disables any currently active filtering, clearing the Filter field in 
the Filter Toolbar. 

Apply Filter 

 

Applies a filter which has just been defined. 

Define Filter 

 

Opens the filter definition window, enabling construction of a 
new filter. 

Note that when filters are active the display window titles will be appended with ‘Filtered’. 

Filter Expressions 

Filters may be specified to varying degrees of complexity, as described below.   

Simple Filters 

A simple filter is a conditional relationship between a single protocol field and some defined value, 
expressed in the format ( FIELD field operator VALUE ), where: 

FIELD is the name of a specific protocol field.  Valid field names and their descriptions are listed in an 
appendix to this document. 

field operator is a comparator which can be one of the following:      

== Equal to 
!= Not equal to 
< Less than 
> Greater than 
<= Less than or Equal to 



 

Sensor Network Analyzer Getting Started Guide                                                            Page 33 of 37 

>= Greater than or Equal to 

VALUE is a constant 

Example: ( mac-layer.seqNo == 170 ) 

Note that simple filter expressions are required to be bracketed. 

Compound Filters 

A compound filter consists of two or more simple filter conditions conjugated in the following manner 

( ( SIMPLE FILTER ) append operator ( SIMPLE FILTER ) ) where: 

append operator is a comparator which can be one of the following: 

&& And 
|| Or 

Example: ((mac-layer.seqNo == 170) || (mac-layer.seqNo == 87)) 

As with simple filters, compound filter expressions are required to be bracketed. 

Multi-Stage Filters 

Typical syntax for multi stage filters: 

( ( SIMPLE FILTER ) append operator ( SIMPLE FILTER ) append operator ( SIMPLE FILTER ) ) 

( ( SIMPLE FILTER ) append operator ( COMPOUND FILTER ) ) 

( ( COMPOUND FILTER ) append operator ( SIMPLE FILTER ) ) 

( ( COMPOUND FILTER ) append operator ( COMPOUND FILTER ) ) 

Example: ((mac-layer.seqNo == 170) || (mac-layer.seqNo == 87) && ( mac-layer.fcFrmType == 
0)) 

Again, multi-stage filter expressions are required to be bracketed. 

The Define Filters Dialog Box 

The Define Filters dialog box may be launched from the Filter Menu, Filter Toolbar or from within the 
Packet Decode window.  The appearance and use of the Define Filters dialog box is described below.  
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Refer to the information above concerning filter expressions for more information on field operators 
and append operators. 

 

Figure 24 Define Filter Dialog 

Each field in the Define Filter dialog is described below: 

 

Field Name The name of a specific protocol field in shorthand notation.  
Valid names are listed later in this manual.  

The protocol field name may be typed or pasted.  Alternatively, 
it may be selected from the drop down list, which contains all 
possible field names. 

When the define filter dialog box is launched from the Packet 
Decode window using the right click it will be preloaded with 
the relevant filter name. When launched from the Filter Menu 
or Filter Toolbar it will default to blank. 

Field Description Is a textual description of the protocol field shown in Field 
Name above it. This is an informational display only, but does 
allow a protocol field to be chosen from the drop down list, 
providing a more meaningful field description.  If a protocol 
field is chosen from this drop down list, it’s shorthand notation
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will be shown in Filed Name above it, replacing any previously 
selected field name. 

Comparator Is the field operator described above in the reference 
information on filter expressions.  A comparator may only be 
selected from the drop down list. 

Value A constant, being the VALUE described in the reference 
information on filter expressions above.  This text field will 
allow you to enter the protocol field value against which the 
comparison is to take place. 

Append  using This button will append the currently defined filter onto the end 
of the preview string using the selected operator as the append 

operator. This allows you to build compound filters.  Valid 
operators are && (and) and | |  (or), chosen from the drop down 
list. 

Apply This button will replace the contents of the preview string with 
the defined simple filter. 

Preview This drop down list will display the filter as it is being created 
and will also allow you to manually update the filter string. You 
will also be able to choose from the drop down list any of the 
last 10 defined filters. 

OK Accept the filter and close the dialog. If the filter has changed 
this will apply the new filter and make it active. 

Cancel Closes the dialog, causing any changes to be discarded. 

 

7 Session Save and Restore 

The Sensor Network Analyzer supports the concept of a user session where all of the configurable 
options, window locations, toolbar positions etc can be saved as a session file and restored at a later 
time. Session files are stored in XML format. 

The operations to Save and Restore a session are available from the File menu. 
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The current session file is shown in the application status bar along the bottom of the application. Any 
changes made to the application since the session file was opened or last saved must be saved using the 
“Save Session” or “Save Session As…” operations. The current session will NOT be automatically 
saved when you exit the application. When the application restarts it will restore the session based on 
the current session file when the application was closed. 

If there is no current session file, the application will maintain the current settings in a file called 
DefaultSession.xml. This file is automatically saved on application exit if there is no current session 
file. 

The following operations are available from the File Menu: 

Open Session… Open (Restore) an existing session file. A file browser 
is shown to allow the selection of a session file. All 
configuration parameters stored in the session file are 
applied to the current application session. 

Close Session Close the current session file and return to the default 
session. If there is no current session this option is not 
available. 

Save Session Save the current session to the current session file (as 
shown in the status bar along the bottom of the 
application). If there is no current session this option is 
not available. 

Save Session As… Save the current session to a new session file. The new 
file becomes the current session file.  

Default Session… Restore (some) current session parameters to their 
default settings. This preserves the current session file.  
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